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How do I run Quite A Box Of Tricks?
Quite A Box Of Tricks is a plug-in for Acrobat 
4.0, 5.0, 6.0 or 7.0. This means that before 
you can run it, you need to put it into the 
Acrobat plug-ins folder. The location of the 
folder depends on where you installed 
Acrobat, but on the Macintosh it is called 
Plug ins and on Windows it is called 
plug_ins (with an underscore).  

You need to be running Windows 95 or 
above (including Windows 98/Me) or 
Windows NT 4.0 or above (including 
Windows 2000/XP); or MacOS 9.1 or above 
on a Power Macintosh (includnig Mac OS X). 
Windows 3.1, 68K Macintosh, and Unix 
systems are not supported. Acrobat is 
required; the free Acrobat Reader (or Adobe 
Reader) will not work.

This PDF file can be used for on-line help in 
Quite A Box Of Tricks. When you click the ? 
button on a dialog, this manual should open 
to the appropriate page. The file must be 
installed in the same folder as the plug-in 
itself.

On the Macintosh, there are three plug-in 
files, which should be called Quite A Box Of 
Tricks, Quite A Box Of Tricks OSX and 
Quite A Box Of Tricks.acroplugin and this 
file should be called Quite A Box Of Tricks 

http://www.quite.com/
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Guide. You can install all plug-in files on any 
Macintosh system; Acrobat will load only the 
correct one. To run native in Mac OS X, you 
need Acrobat 5.0.5 or above.

With Acrobat 6.0 and 7.0 on the Macintosh 
only, the plug-ins folder is now invisible. 
Quite A Box Of Tricks now includes an 
installer to simplify this. To add plug-ins 
manually, locate the Acrobat 6.0 application 
icon in the Finder (not a folder, and not a 
shortcut.) Use Command+I to get the 
information pane. An entry Plug-ins 
appears, and you can use it to add, remove 
or disable plug-ins. Add all four of the files 
above, even though the guide is not actually 
a plug-in. 

On Windows, the plug-in should be called 
qbox32.api, and this file should be called 
qbox32.pdf.

Once the plug-in is installed, and Acrobat is 
restarted, you should see a new menu item 
appear: Plug-ins > Quite A Box Of Tricks. 
That gives access to all of the features of Box 
Of Tricks in one place. 

As a short-cut, you can also start the Info 
function of Box Of Tricks by clicking the i icon 
with an arrow that appears on the toolbar. In 
Acrobat 6.0 onwards, this appears on the 
Advanced Editing toolbar. If you do not see 
this, select View > Toolbars > Advanced 
Editing.

After installing the plug-in it will run in demo 
mode. In this mode every page changed will 
have an “X” placed over it, but all the parts of 
Box Of Tricks can be tested. Warning: 
These “X” marks cannot be removed so 
take care not to save your files and 
destroy your original documents!

When you purchase a license you will receive 
a serial number and private code. Click the 
Licensing button, type your details and the 
two numbers. The serial number you receive 
is going to look like this: 1234-5678-1234-
1234, with 16 digits in all. The private code is 
a 4 digit number like 9876. If you don’t seem 
to have both, check to see if they have been 

written together like this: 
1234-5678-1234-1234 9876.

The Licensing button is on the About 
screen. This screen is shown when you first 
run Box Of Tricks, and can be pulled up at 
any time by clicking the ?? (two question 
marks) button on a Box Of Tricks screen. 
This will show the serial number, but never 
the private code, so you should keep both in 
a safe place.

What can I do with Box Of Tricks?
Box Of Tricks is designed to solve many 
problems which were previously time 
consuming, expensive, or just impossible to 
do with a PDF file.

It has five main screens, each with a range of 
functions.

Shrinking (page 6)

• Allows many PDF files to be reduced in 
size for e-mailing, web use, or to fix a poor 
choice of options in Distiller.

Colour conversion (page 14)

• Convert RGB to CMYK in PDF 
documents. On MacOS and Windows 
systems (except Windows 95 and NT 
4.0), ICC profiles can be used. This may 
be essential for some methods of printing 
colour. 

• Convert all spot colour to process 
(CMYK). 

• Convert PDF files to greyscale. This can 
reduce the size, and may print more 
cleanly to a black and white printer.

• Convert all text in a PDF file to black. 
Useful if a document with coloured text 
(e.g. links) is to be printed in black and 
white, to avoid the text becoming shades 
of grey. This can also be un-done, 
restoring text to its original colour.

Form field management (page 23)

Merge form fields into documents or remove 
them. This can reduce document size, and 
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avoid problems where form fields change or 
disappear during printing.

You can also remove annotations (notes, and 
the many new types of annotation in Acrobat 
4.0). This avoids the possibility that they will 
print by accident. Or, you can make 
annotations into a part of the document, so 
they cannot be removed and will always print.

Transformation (page 24)

• Thicken hairlines (very thin lines) in PDF 
files. This can be valuable if printing at 
very high resolution, since thin lines may 
become so thin that they are invisible.

• Mirror, scale, or rotate pages by any 
angle.

PDF Info (page 26)

• Get full details on the images and text in a 
file, including type (RGB, CMYK etc.), 
compression ratio, and JPEG level. For 
text, find the font used and whether it was 
embedded and/or subsetted.

• Search a document for RGB images, or 
find the largest images.

• Recompress or subsample individual 
images in a document.

What can’t I do with Box Of Tricks?
Although Box of Tricks has many powerful 
functions, it’s important to understand its 
limitations too. Some of the important ones 
apply to colour processing.

• Box Of Tricks is not a complete colour 
management solution. Although it can 
convert RGB to CMYK, optionally with 
ICC profiles, it cannot do reverse 
translations such as CMYK to RGB or 
convert one CMYK to a different CMYK. 
Also, even if an ICC profile is used for 
conversion, Box Of Tricks cannot control 
how Acrobat displays the colours in the 
file, so no monitor profile is possible.

• Box Of Tricks can convert all of the spot 
colours in a file into process colours or 

greyscale, but it does not provide any way 
to check what spot colours are included, 
to convert them selectively, or to convert 
other types of colour into a spot colour. 
Our Quite Revealing product offers more 
choices for dealing with spot colour.

What about compatibility?
This version of Quite A Box Of Tricks was 
written for Acrobat 4.0, 4.05 and versions up 
to 7.0. Before upgrading to a later version of 
Acrobat you are advised to check the latest 
information on our web site, 
http://www.quite.com. It may not work with 
earlier versions of Acrobat.

PDF files have a version number, and 
(confusingly) this is not the same as the 
Acrobat version number. Acrobat 3.0 wrote 
PDF version 1.2, while Acrobat 4.0 writes 
PDF version 1.3, Acrobat 5.0 writes PDF 
version 1.4, and so on. If you open a newer 
version of PDF with Quite A Box Of Tricks 
you will get a warning message - again, you 
are advised to check for the latest version of 
Box Of Tricks using our web site.

Processing a file with Box Of Tricks does not 
change its compatibility, even though 
Acrobat will change the PDF version number. 
If a file started out compatible with Acrobat 
4.0, it will still be compatible with 4.0 after any 
processing. But if it was only compatible with 
Acrobat 5.0, it will usually remain compatible 
only with Acrobat 5.0. 

To emphasise: processing a file with Quite A 
Box Of Tricks won’t change its compatibility. 
But, Acrobat will change the version number 
unnecessarily; we cannot stop this.

Also, any processed file will no longer be an 
ASCII PDF (as if it were created by Distiller 
with the ASCII setting). This should not 
usually be important, as there do not seem to 
be any applications that require an ASCII 
PDF.

In summary: Box Of Tricks will read any PDF 
file from Acrobat 7.0 or below, but the files it 
writes are compatible only with 3.0 or above. 

http://www.quite.com/
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Before working with any release over 7.0, 
check for updates to this software.

What was new in Quite A Box Of 
Tricks 1.2?
Most of the changes in Quite A Box Of Tricks 
1.2 are invisible. They are there to support 
the features of files made with Acrobat 4.0, 
though Quite A Box Of Tricks still works fine 
with Acrobat 3.0.

The most noticeable change is in the Form 
field management (page 23) function, which 
can now work with the many new annotation 
types in Acrobat 4.0.

Acrobat 4.0 raised a number of unexpected 
issues. More information can be found in the 
following sections:

• Was JPEG compression in Distiller 4.0 
faulty?  12

• Were ICC profiles broken in Distiller 4.0?  
20

• What’s this about annotations?  23
• I get errors using the text touch-up tool. 

Why?  24

What was new in Quite A Box Of 
Tricks 1.2h?
1.2h looks very similar to previous versions, 
but has one important change. It now fully 
supports a feature of PDF called “form 
XObjects”. You don’t have to worry about 
what these are! Previous versions would 
refuse to work if these things were in a PDF. 
From 1.2h, everything works as normal if 
there is a form XObject. The main change to 
this manual has therefore been to remove 
almost all references to restrictions and form 
XObjects.

What was new in Quite A Box Of 
Tricks 1.5?
Quite A Box Of Tricks 1.5 has enhancements 
to work well with Acrobat 5.0, but is equally at 

home with Acrobat 3.0 and 4.0. When used 
with Acrobat 5.0 a new feature is available: 
support for Acrobat’s new “batch 
sequences”. See How do I use automation 
with Acrobat 5.0 onwards? (page 30) for 
details. 

In addition, Box Of Tricks 1.5 will detect and 
warn if you try to convert the colours in a PDF 
file that uses transparency; see the error 
description in What do the warning 
messages mean? (page 20) 

Box Of Tricks has also been updated to 
recognise compression from Distiller 5.0 and 
Photoshop 6.0.

What’s new in Quite A Box Of Tricks 
1.6?
Quite A Box Of Tricks 1.6 has been changed 
to support Acrobat 6.0 and PDF 1.5. This 
includes reporting on JPEG2000 images 
embedded in a PDF. JPEG2000 images can 
usually be converted to greyscale or CMYK; 
if they cannot be converted a message is 
issued. JPEG2000 images are not shrunk in 
1.6.

What’s new in Quite A Box Of Tricks 
1.7?
Quite A Box Of Tricks 1.7 has been changed 
to support Acrobat 7.0 and PDF 1.6. PDF 1.6 
did not include any new types of image 
compression. On the Macintosh, Acrobat 7 
plug-ins are separate from all earlier 
versions, but Quite A Box Of Tricks now 
includes plug-ins for both Acrobat 7.0 and for 
earlier versions; Acrobat will load the correct 
one.

How do I get support?
We want you to be able to use Quite A Box 
Of Tricks to solve your problems. If you have 
a question that is not answered in these 
pages, or you think you have found any sort 
of bug, check on our web site 



Quite A Box Of Tricks Guide Page 6 of 33 Version 1.6

http://www.quite.com/ for the latest 
information. If that doesn’t help, please 
contact your reseller or send an e-mail to 
help@quite.com. 

All software has bugs, and although we’ve 
had the help of hundreds of beta testers for 
Quite A Box Of Tricks, there may still be 
some lurking. We need your help to tell us 
when you find a bug, so that they can be fixed 
as quickly as possible. Please don’t assume 
that someone else has already found it 
andtold us about it. Thank you!

Shrinking
• How can Quite A Box of Tricks shrink my 

PDF files?  6
• Will every PDF file shrink?  7
• What does the Apply button do?  7
• What does the Get Current Size button 

do?  8
• What does the Restore button do?  8
• What is “text and line art”?  9
• What is the rest of the space in the PDF file 

used for?  9
• What is image subsampling?  9
• What do the compression types mean?  10
• What compression settings should I use?  

10
• My file didn’t shrink - why not?  11
• Why doesn’t this image have the 

resolution and compression I asked for?  
12

• How do I shrink just one image?  12
• Was JPEG compression in Distiller 4.0 

faulty?  12

How can Quite A Box of Tricks 
shrink my PDF files?
When you create a PDF file with PDFWriter 
or Distiller, you should have noticed that 
there are a number of compression settings. 
These affect both the quality and the size of 
the PDF files you produce. In general, if the 
quality is higher, then so is the size. If you are 
prepared to accept a lower quality, you can 
have a smaller PDF file.

Not every setting reduces quality. For 
instance, “compress text and line art” should 
always be left switched on, as this does not 
affect the quality in any way; and 
compression of images should never be 
completely off: subsampling/downsampling 
off and manual ZIP (8 bit) compression will 
preserve images exactly.

If you have already made a PDF file, you may 
wish to reduce the size, and you may be 
willing to see the quality reduce to achieve 
this. The Shrink function in Quite A Box Of 
Tricks can make some savings that you could 

http://www.quite.com/
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have made with different Distiller or 
PDFWriter settings. In some cases you can 
produce a smaller file than you might have 
been able to when using Distiller; and, since 
PDFWriter offers less compression choices, 
you can often shrink files made with 
PDFWriter.

Also, Distiller 4.0 does not compress files in 
the same way as 3.0, and there is the 
potential for Quite A Box Of Tricks to make 
savings for you. However, Distiller 4.05 
appears to resolve most of these issues. See 
Was JPEG compression in Distiller 4.0 
faulty? (page 12)

Quite A Box Of Tricks has four techniques for 
reducing file size:

1. Images can be reduced in resolution. For 
instance, if you have an image at 150 
pixels per inch (dots per inch, or dpi), and 
you are prepared to reduce it to 75 dpi, 
then the image may be only 25% of its 
original size.

2. Images can be recompressed. Distiller 
and PDFWriter offer a choice of 
compression schemes. These include 
“ZIP”, which maintains the image exactly, 
and five JPEG choices. “JPEG low” 
compresses less, but it is almost 
impossible to see any drop of quality for a 
photograph. “JPEG high” compresses 
much more, but you will see a lower 
quality. Quite A Box Of Tricks also offers 
“JPEG Extra”, which can be substantially 
smaller than “JPEG high”.

3. Text and line art can be compressed, if it 
they were not made that way originally.

4. If the ASCII option was accidentally used 
in creating the file, it will be removed; this 
can reduce file sizes by almost 20% with 
no loss of quality.

Will every PDF file shrink?
Not every PDF file will shrink. If the text and 
line art is already compressed, and the ASCII 
option was not used, the only savings can be 

made with images. So, a file with no images 
cannot usually be made any smaller. 

Images can usually be shrunk, but when you 
do so the quality may decrease. For every 
file, there is a quality which is acceptable, and 
which you will not want to go below. You can 
in theory reduce every image to 1 dpi, which 
will be a series of one inch coloured squares; 
but that is not likely to be useful.

It is up to you to decide what quality is 
acceptable to you. Box Of Tricks makes it 
easy to experiment with different settings.

Remember that the file will not shrink on disk 
until you use Save As. Simply using Save will 
always make a file larger, no matter how 
much shrinking you have done.

If you’re using the demo version, it puts an 
“X” over each page. These “X” marks do use 
a little space, so if there was not much space 
to save, the file may even get larger! 
Remember that you won’t be able to remove 
those “X” marks. Don’t save over your 
original file!

What does the Apply button do? 
The Apply button will use the settings on the 
shrink screen, to process images on either 
the current page, or in the entire document. 

The first time you use Apply for a document, 
it will also compress text and line art in the 
entire document.

In detail, each image is processed as follows.

1. A check is made to see if the image 
appears more than once. This is 
important, because the image may be 
used at different sizes in the document. 
The largest appearance of the image is 
used to calculate its current dpi.

2. If you have selected Preserve screen 
shots, the image is scanned to see if it is 
likely to be a screen shot. (This cannot 
always be accurately determined). If the 
image seems to be a screen shot, it is 



Quite A Box Of Tricks Guide Page 8 of 33 Version 1.6

simply compressed with ZIP compression 
and we skip to step 5.

3. In all other cases, if you have asked to 
subsample the image, it will be 
subsampled to the specified resolution 
(dpi) value. This does nothing if the image 
is already smaller than the requested dpi - 
it is not enlarged.

4. The image is now compressed using the 
specified compression. If the compression 
is JPEG, a second compressed copy is 
made using ZIP, because this is 
sometimes smaller. Whichever of these is 
smaller is kept, the other is ignored.

5. The size in bytes of the newly 
compressed image is compared with the 
image currently in the document. If the 
new image is smaller, it replaces the 
current one on every page where it is 
used. Otherwise, the new image is thrown 
away.

What does the Get Current Size 
button do?
The Get Current Size button on the Shrink 
screen will go through the PDF file and work 
out how much space is used by all of the 
images in the page, and also all text and line 
art. When the calculations are complete, the 
Get Current Size button will disappear, and 
be replaced by the answers.

You can use this to decide whether a file is 
worth bothering to shrink, before using the 
Apply button. You don’t have to use the Get 
Current Size button before using Apply, 
because Apply will start by doing 
calculations if it has to.

The Shrink screen will also show how much 
space has been saved by compressing or 
subsampling images, or by compressing text 
and line art.

The figures you calculate will remain until the 
file is modified, or saved. If it is modified (for 
instance, by deleting a page), you will have to 

calculate again, and the record of space 
savings will start again at zero.

Get Current Size always works out figures 
for the entire file. It ignores the scope (current 
page/entire document).

Note that the figure for text and line art may 
occasionally show the word “shared”. This 
means that Quite A Box Of Tricks has 
detected that the same page content is 
reused in more than one page. This is 
unusual, but possible. Box Of Tricks will not 
attempt to compress any text and line art if 
part of it is shared, as compressing would 
make separate copies of the shared 
information. This could end up making the file 
larger, not smaller.

What does the Restore button do?
You can use the Restore button if you don’t 
like the results of shrinking. For instance, you 
can use this if the quality is now too low.

You can restore the entire document, or just 
the current page, by selecting from the Scope 
list.

Restoring makes it very quick and easy to try 
different compression options.

Restoring is not an “Undo” which removes 
only the last action. It takes the images on the 
page or document back to the state they had 
before you started shrinking. 

If you modify the document, for instance by 
deleting a page, or if you save the file, you 
can no longer restore. Any future changes 
that you make with Apply can only be 
restored to this point.

When you use Apply, the original image will 
be used if possible. For instance, if you have 
a 200 dpi image and reduce it to 80 dpi, then 
reduce it to 70 dpi, it is the original image, not 
the 80 dpi image, that is reduced. In effect, a 
restore is performed on the image. 

However, if you want to compress an image 
less, for instance if you subsampled it to 50 
dpi and now want to try 70 dpi, you should 
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use Restore first. That’s because the newly 
compressed image will be larger than the 50 
dpi image, and so will not be used.

What is “text and line art”?
Adobe’s products use the option “compress 
text and line art”, and we use the same term. 
But the name does not give the full story.

A better term might be “page contents”. The 
page contents contain all of the drawing 
instructions that describe what you will see 
on the page.

• The page contents include all of the text 
on the page, but not any fonts.

• The page contents don’t usually include 
bitmaps or images, but do contain a few 
instructions to indicate where the images 
will be placed - so even a page with 
nothing except images will have some 
page contents.

• Very small images may be called “inline 
images”. These are usually images of 8K 
or less. They will be kept right in the page 
contents. This helps to reduce file sizes.

Page contents usually compress well. There 
is almost never any reason to leave them 
uncompressed, because the quality is not 
altered by compression. 

When Acrobat tools, or Box Of Tricks, 
compress text and line art they will use ZIP 
compression. It also removes the effect of the 
ASCII option in Distiller or PDFWriter. This 
option increases file sizes by up to 25% with 
no real benefit.

Box Of Tricks will compress the page 
contents for every page, the first time you use 
the Apply button. It only needs to do this 
once.

What is the rest of the space in the 
PDF file used for?
If you add up the space used by text and line 
art, it won’t equal the size of the file. Some of 

the other things using space in a PDF file, 
which shrinking won’t affect, are listed below.

• Fonts. Embedded fonts may use a good 
deal of space (up to 100K for large and 
complex fonts). Even fonts which are not 
embedded may need several hundred 
bytes to give the information needed by 
Acrobat Reader to find or substitute the 
font accurately.

• Links, bookmarks etc. Each link or 
bookmark will use space. This is usually a 
small proportion of the file, but heavily 
cross-referenced files may turn out to be 
more than 50% links. Adobe FrameMaker 
5.5 puts in a dummy link for every 
paragraph, so the files it produces may be 
larger than expected.

• Form fields. These too use space, 
sometimes more than expected if form 
fields are used to put navigation 
throughout a large document. See Form 
field management (page 23) for some 
options in reducing the space used by 
form fields.

• Overheads. The PDF file format has to 
contain information about all of the 
objects in the file, including each page, 
and every image. These overheads are 
usually not a large proportion of the file.

• Wasted space. Each time you save a PDF 
file with File | Save, the changes you 
make are added on the end. So Save 
always makes a file longer, even if you 
delete pages or run Shrink. To reclaim this 
wasted space you must use File | Save 
As.

Tip: In Acrobat 5.0, Tools | PDF Consultant 
| Audit Space Usage can help in 
understanding space problems, because it 
gives the space used in various categories.

What is image subsampling?
Subsampling, simply put, throws away 
information. For instance, if you have an 
image at 300 dpi, you can reduce it to 150 dpi 
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by throwing away every other pixel in the 
image. Distiller does this when you select the 
downsample or subsample option, and Box 
Of Tricks will also do this when shrinking (if 
your settings ask it to).

Often images are scanned and stored at 
much too high a resolution. For instance, 150 
dpi to 200 dpi is usually enough for 
photographs that are to be printed on any 
common desktop printer at resolutions up to 
800 dpi. So subsampling can be a valuable 
way to reduce space. Nevertheless you 
should check the quality yourself to see what 
effect you are having on important files.

Subsampling is almost never a good thing for 
screen shots, where every pixel matters. For 
this reason, Box Of Tricks offers a Preserve 
screen shots setting. When this is on, Box 
Of Tricks analyses each image to see if it is 
probably a screen shot, and if so, it does not 
subsample (and always compresses only 
with ZIP). Box Of Tricks can only guess 
whether a specific picture is a screen shot, 
but it usually seems to guess right. However, 
if a screen shot has already been 
compressed with JPEG, it is much less likely 
to be recognised because of the small 
changes made by JPEG compression.

What do the compression types 
mean?
The choice for colour is between ZIP and 
several types of JPEG. The choice for black 
and white (monochrome) is between ZIP and 
CCITT group 4. So, what is the difference?

• ZIP is a very effective way of compressing 
files so they can be retrieved exactly as 
they started; that is, it is lossless. ZIP can 
be used for any image, and the quality will 
not be affected in any way. Box Of Tricks 
uses a special technique of compressing 
each image twice, once as ZIP. If the ZIP 
version is smaller it will be used anyway.

• CCITT group 4 is also lossless, and it is 
specially designed for black and white 
images (not shades of grey, just black and 

white). It is actually based on the 
compression used by fax machines, and it 
is very good at compressing typical black 
and white images - drawn lines or 
scanned text. For that kind of original, it 
will compress better than ZIP, so we 
recommend its use. 

• JPEG is always lossy. That is, you do not 
get back exactly the same collection of 
pixels and colours that you started with. It 
is specifically designed to compress 
photographs, not as a general purpose 
tool (the “P” stands for Photographic). It 
makes use of specific properties of typical 
photographs and a good understanding of 
the way the human eye works, to make 
the changes in such a way we are less 
likely to notice them. By having some 
freedom to change images, JPEG can 
make dramatic space savings. 

The more freedom JPEG is given, the 
more it will compress a file, but the effects 
will start to become noticeable. The 
gentlest compression Distiller or Box of 
Tricks will do is called “JPEG low”. At this 
level of compression it is almost 
impossible to detect a change in a photo, 
even for the most demanding work. 
Distiller and Box of Tricks have a range of 
other settings, leading up to “JPEG high”. 
This will usually have a noticeable effect. 
Box Of Tricks offers one more setting, 
“JPEG extra”. This is smaller still - but the 
quality is as a result poorer still.

What compression settings should 
I use?
We can’t really answer that for you, because 
only you know what kind of work you are 
doing, and how demanding the final results 
will be. We have collected five settings, which 
match common needs, but we encourage 
you to experiment. If you have time, you can 
apply different settings page by page or even 
- using the Info tool - image by image. The 
Info tool also lets you find the largest images 
quickly, so you know where to concentrate.
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These are the settings in the initial release of 
Box Of Tricks.

• Lossless guarantees the image is not 
changed in any way, but makes it smaller 
if better compression is available. This 
may be useful if a file was made with 
compression off, or the ASCII setting on, 
in Distiller or PDFWriter, or with Acrobat 
2.1 which compressed less well. It will not 
usually be able to reduce the size of any 
image already compressed with JPEG.

• Chosen for press is a very high quality 
setting, which is probably suitable for use 
with professional printing. It may not 
reduce files in size unless the person 
distilling it forgot or chose not to 
compress; or the images were scanned at 
much too high a resolution. Because of 
the high costs associated with printing on 
a press, you should always obtain and 
check proofs that show what the final 
results will look like.

• Chosen for printing is intended for 
documents that must look good when 
printed on typical desktop ink-jet or laser 
printers. 

• Chosen for screen is intended for 
documents that will mainly be viewed on 
screen. These are likely to produce 
adequate, if not spectacular, results when 
printed. It is recommended that internet 
documents are designed for screen; few 
users have expectations of perfect 
printing and so it is almost never worth 
burdening all users with much larger files 
to support this.

• Chosen for smallness is intended to 
produce very small files, with images that 
won’t look great but should be 
recognisable. This may be a good setting 
for files for use on the web, if fast 
download times are more important than 
quality.

• Rough layout removes almost all of the 
detail from images. The pages will be 
recognisable, and the text will not be 

affected. This may be very valuable for 
making small files to e-mail to people who 
are only interested in the text, and seeing 
the general layout of the page.

My file didn’t shrink - why not?
Here are some reasons a file might not 
shrink.

• You may not have used the Apply button, 
or it may not have been able to reduce 
space. For instance, a file with no images 
may not be capable of being shrunk. Or, if 
a file contains images at 72 dpi, and you 
choose 100 dpi for shrinking, they aren’t 
likely to get any smaller. The information 
at the bottom of the Shrink screen will 
show you Box Of Trick’s estimate of how 
much space will be saved.

• You may have used Save rather than 
Save As. Only Save As will reclaim 
space.

• Optimizing the file may make it larger! If 
you select Optimize when you Save As, 
Acrobat first tries to make the file smaller, 
by recognising duplicated objects. 
However, this may not make any 
difference. Then, optimizing writes extra 
information to the PDF file to allow it to be 
retrieved a page at a time from the Web. 
This information, though useful, does 
make the file a little larger.

• How are you finding out the file size? 
There are a surprising number of different 
ways to find out the size of a file, and they 
don’t always give the same answer! In 
Windows, locate the file in Windows 
explorer, right-click on the icon, and select 
Properties. In the Macintosh, locate the 
file in the Finder, and use Command+I. 
You can also use File > Document Info > 
General or File > Document Properties 
> Summary in Acrobat, but the figure is 
only accurate just after a file is opened, or 
just after it is saved.
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Why doesn’t this image have the 
resolution and compression I 
asked for?
There are several reasons why Box Of Tricks 
may not appear to change an image’s 
resolution, or compress it with the chosen 
compression. 

• If the image doesn’t get any smaller after 
it has been processed, it is ignored, and 
the original is left instead. For instance, 
suppose you have a 100 dpi image 
compressed with “JPEG high”. If your 
settings ask for it to be reduced to 75 dpi 
and compressed with “JPEG low”, this will 
probably produce a larger image, and so 
Box Of Tricks is smart enough to leave it 
alone. If you are trying a range of settings, 
Box Of Tricks will keep the smallest 
image; if you want to try something less 
aggressive, use the Restore button first.

• If the image seems to be a screen shot 
and the Preserve Screen Shots setting 
is in effect, it won’t be subsampled, and it 
will only be compressed with ZIP.

• If the image is a inline image, a very small 
image mixed with text and line art, it is not 
altered in any way. See What does the 
image information mean? (page 27)

• Box Of Tricks always makes a copy of 
each image with ZIP compression as well 
as the requested compression, just in 
case it is smaller that way. If the ZIP copy 
is smaller, it is used instead.

• In certain, unusual, cases, an image may 
be used in more than one place in a file, 
possibly at different sizes. In this case, 
Box Of Tricks uses the copy placed at the 
largest size to calculate the dpi.

How do I shrink just one image?
To shrink just one image go to the Info 
screen, and click on the image, then click on 
Shrink Image. You will have the same 
choice of settings as on the regular shrink 

screen. See What does the Shrink Image 
button do? (page 29)

Was JPEG compression in Distiller 
4.0 faulty?
The following information is based only on 
our independent evaluation, and refers to 
features in Adobe’s products which are 
subject to change without notice. 

There were several changes to JPEG 
compression in Distiller 4.0. Some were 
definitely intended, and we suspect others 
were a mistake, that were in fact corrected in 
a later release. This describes the situation 
with the initial release of Distiller 4.0, on both 
Macintosh and Windows.

To begin with, the names of the five built in 
compression types were changed. The 
important thing is that the names in Distiller 
3.0 described how much compression is to 
be done, while the names in Distiller 4.0 
describe the quality. So, the names seem to 
be the exact opposite. This table shows the 
names used.

The change in names is easy to understand, 
but the other changes are surprising. 

Studies by Quite have found that Distiller 4.0 
does not use five different levels of JPEG 
compression. We have found that for colour 
images, there are only three different levels, 
and for greyscale images, only two different 
levels.

Distiller 3.0 
name

Distiller 4.0 
name

File size

high minimum Smallest

medium-high low

medium medium

medium-low high

low maximum Largest
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For colour, minimum and low have been 
found to give identical results. Also, medium 
and high give identical results. For greyscale 
images, medium, high, and maximum have 
all been found to give identical results.

Each image is different, but the following 
results may be of interest. They are all based 
on distilling the same colour photograph of 
about 1 megabyte.

Because of this, we have decided to keep 
Distiller 3.0’s names and compression rules 
in Quite A Box Of Tricks, even if used with 
Acrobat 4.0. You may be able to get major 
savings using Quite A Box Of Tricks on files 
produced with Distiller 4.0. 

Distiller 4.05 appears to resolve most of the 
issues. Contact Adobe to receive this 
upgrade, which at the time of writing was 
available only on CDROM. For 

completeness, here are the results of the 
same test with Distiller 4.05.

Now, the same test with Distiller 5.0.

Distiller 6.0 and 7.0 produce similar results, 
unless it is allowed to use JPEG2000 
compression.

Remember, this is only one sample file; your 
results will vary.

Starting with version 1.2f, Quite A Box Of 
Tricks will try to identify the version of Distiller 
used for compression of an image, in PDF 

Distiller 
3.0 

name

Distiller 
3.0 

compres
sion 

Distiller 
4.0 

name

Distiller 
4.0 

compres
sion

low 33% maxi-
mum

56%

medium-
low

22% high 25%

medium 6% medium 25%

medium-
high

5% low 4%

high 4% minimum 4%

Distiller 
3.0 

name

Distiller 
3.0 

compres
sion 

Distiller 
4.05 

name

Distiller 
4.05 

compres
sion

low 33% maxi-
mum

26% 
(Win),
22% 
(Mac)

medium-
low

22% high 6%

medium 6% medium 4%

medium-
high

5% low 4%

high 4% minimum 3%

Distiller 
3.0 

name

Distiller 
3.0 

compres
sion 

Distiller 
5.0 

name

Distiller 
5.0 

compres
sion

low 33% maxi-
mum

14%

medium-
low

22% high 8%

medium 6% medium 5%

medium-
high

5% low 4%

high 4% minimum 3%
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Info (page 26). Sometimes it cannot tell the 
version used, for instance the text JPEG 3.0 
med/4.05 max indicates this was either 3.0 
with the Medium setting or 4.05 with the 
Maximum setting. 

Recall that Quite A Box Of Tricks bases its 
compression on 3.0 too, so there is no 
difference between images compressed with 
Distiller 3.0, and those re-compressed by 
Quite A Box Of Tricks.

Colour conversion
• Why would I convert PDF colours?  14
• How do I control the conversion to CMYK?  

15
• What is an ICC profile?  15
• Why use ICC profiles?  15
• How do I use an ICC profile with Quite A 

Box Of Tricks?  16
• Where do I get an ICC profile?  16
• What about input profiles?  17
• How do Distiller 3.0 options affect ICC 

processing?  17
• Is Quite A Box Of Tricks a PDF Colour 

Management Solution?  18
• What about UCR, GCR and black 

generation?  18
• Why is part of my file still in colour after 

converting to greyscale?  19
• What is spot colour and how is it 

converted?  19
• Were ICC profiles broken in Distiller 4.0?  

20
• What do the warning messages mean?  20
• Why can I undo All Text To Black but not 

the other conversions?  21
• Text didn’t convert to black - why not?  22

Why would I convert PDF colours?
Here are some reasons why you might want 
to use the colour conversion functions in 
Quite A Box Of Tricks.

• Many systems of printing colour on a 
press require that colours be in CMYK, 
that is a mixture of the colours Cyan, 
Magenta, Yellow, and blacK. These are 
the same as the inks used in printing, so 
the colours in the file are used directly to 
select the amount of ink used. 
Unfortunately, many files use RGB 
colours, that is a mixture of Red, Green 
and Blue, as used for the colours of light 
in a monitor.

Some systems will automatically convert 
RGB to CMYK, so on these systems 
conversion to CMYK is not a vital issue. 
But others simply will not work, that is, 
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they will not print in the correct colours or 
print at all, if RGB is used. 

Box Of Tricks can do this conversion for 
you, if the printing system does not do it 
automatically. 

• If a file contains spot colour, Box Of Tricks 
can optionally convert these to CMYK. 
This avoids problems where unwanted 
printing plates are produced.

• Quite A Box Of Tricks will also convert to 
greyscale. If a file is only to be printed in 
black and white, this may reduce the size, 
and may make it easier to predict the 
result.

• Text can be converted to black (not 
greyscale). This may be useful if a 
document was prepared with coloured 
text for viewing on screen or colour 
printing, and is now to be printed in black 
and white. Black text may look better than 
grey text.

How do I control the conversion to 
CMYK?
When you select CMYK conversion, a Setup 
button is available. With this you can control 
the conversion process.

• You can select between a fast, fixed 
conversion to CMYK and one which uses 
ICC profiles, provided your operating 
system supports them (Windows 95 and 
NT 4.0 do not). See How do I use an ICC 
profile with Quite A Box Of Tricks? (page 
16) The fixed conversion applies 
“maximum UCR”, and tends to minimize 
the amount of ink applied to paper.

• For text and line art you can select 
whether or not to convert. See What is 
“text and line art”? (page 9)

• For text and line art you can also select 
that equal amounts of R, G, B colour are 
converted directly to greyscale, rather 
than a CMYK mixture. This may produce 
clearer printing of black text and thin lines, 
and is usually recommended. 

• For images, you can choose whether or 
not to convert. 

• For images, you can select that they must 
be recompressed only with ZIP. This 
guarantees that the image is not 
degraded. By default, images that had 
been compressed with JPEG will be 
recompressed with the same JPEG 
settings. If the ZIP option is on, the 
converted file size may be many times 
larger than the original file size.

• You can choose whether or not all spot 
colours are converted to CMYK. This is off 
by default, so that spot colours are 
preserved. See What is spot colour and 
how is it converted? (page 19)

What is an ICC profile?
ICC profiles are files which describe how 
colours are to be converted for particular 
devices (printers, scanners, or monitors). 
Each profile describes how to convert colours 
to or from a “universal” space, which is device 
independent. 

This means that you can take a colour from 
one device (such as a scanner), and convert 
it to universal space, then convert to the 
colour for a different device (such as a 
printer). This should keep the colours as 
accurate as possible, within the limitations of 
the devices (for instance, few printers can 
make a bright green or bright blue).

Why use ICC profiles?
Traditionally colours are expressed as RGB 
(red, green and blue) for monitors and CMYK 
(cyan, magenta, yellow, and black) for 
printers, including colour presses. This works 
well, but the results of printing the “same” 
colour can vary widely from device to device. 
Monitors may use different settings, so red, 
green and blue look different. And, printers 
use different inks, printing technologies and 
paper which can produce different looks. 
“Generic” RGB and CMYK has been 
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considered “good enough” for many people, 
but others have struggled to produce the 
same colour on screen, on paper proofs, and 
on the final printing press, to satisfy 
demanding clients.

A number of different ways to manage this 
have grown up, called “colour management”. 
For instance, Adobe Photoshop has allowed 
the user to pick from a list of inks and papers, 
and adjust their properties. This works but 
has a number of disadvantages. It can only 
be used for Photoshop images; other 
applications will do colour management in a 
different way (which has to be learned 
separately) or not at all; and setting it up 
correctly requires considerable expertise.

ICC profiles can replace all of the manual 
settings. If used correctly, they are easier to 
work with (though creating ICC profiles 
remains a highly skilled task). Above all they 
are a standard (described in full on 
http://www.color.org), and the idea is that 
they should be usable with a wide variety of 
applications and systems. Apple and 
Microsoft have added ICC support to their 
operating systems, so there should be 
widespread use of ICC profiles before too 
long.

Acrobat 4.0 introduced embedded ICC 
profiles. These are profiles right inside a PDF 
file, that describe how colours are to be 
interpreted. 

How do I use an ICC profile with 
Quite A Box Of Tricks?
When converting to CMYK, click on the 
Setup button first. This allows you to choose 
between a built-in (fixed) conversion, and 
ICC profile conversions. This is available only 
if the operating system supports ICC profiles. 
MacOS 7.5 and upwards support Apple's 
ColorSync. Windows 98, 2000 and XP 
support Microsoft's ICM 2.0. Windows 95 and 
Windows NT 4.0 do not have any built-in 
colour management, so only the fixed 
conversion is possible. 

After selecting to use colour management, 
you must click CMYK profile. You then get a 
list of profiles to choose from.

• On the Macintosh, the list contains all 
suitable profiles installed in the 
ColorSync™ Profiles folder within your 
system folder. Before ColorSync 2.5 this 
is a folder within Preferences. From 
ColorSync 2.5 the folder is at the top level 
of the system folder, and can contain 
subdirectories (but only one level deep).

• On Windows 98, you will see a file open 
dialog. This can be used to open any 
profile. ICC profiles are saved as type 
*.icm. The opening folder will be the 
system's default profile folder, such as 
c:\windows\system\color. All profiles 
are shown, including unsuitable ones 
(those for monitors or scanners). To get 
more information on a profile, right click 
and select Properties.

Where do I get an ICC profile?
As ICC profiles catch on, this is a question 
many people will be asking. There are 
several answers.

1. If you have installed high end applications 
on the system, you may already have a 
good collection of relevant profiles.

2. For printers, especially high-end proofers 
we expect the printer manufacturer to 
supply them. Notice that profiles are only 
applicable to PostScript printing when we 
deal with Quite A Box Of Tricks. This is 
because non-PostScript printing in 
Windows or Macintosh will always be 
done by converting back to RGB, making 
a conversion to CMYK a waste of time!

3. For offset and other industrial printing, 
profiles are available for generic 
specifications of device, such as 
newsprint printing.

4. It is possible to create ICC profiles for 
particular presses and types of ink and 
paper using equipment that analyses 

http://www.color.org/


Quite A Box Of Tricks Guide Page 17 of 33 Version 1.6

printed samples. This is an expensive and 
skilled task.

5. Adobe Photoshop 5.0 allows you to set a 
combination of ink and paper settings, 
with other advanced settings like 
UCR/GCR, and save them as an ICC 
profile.

6. If you are sending work for inclusion in 
another publication, for instance a colour 
advertisement, ask for the ICC profile that 
applies to output. Of course, ICC profiles 
are still fairly new, and they may not know 
what you are talking about, but it is worth 
a try.

What about input profiles?
Those who understand ICC thoroughly will 
be asking what Quite A Box Of Tricks does 
for input profiles. In general, to convert from 
RGB to CMYK you would need a profile for 
the RGB device. Quite A Box Of Tricks does 
not support this. Here's what it does.

In Acrobat 3.0, there are three ways to 
specify colour in a PDF file, that will need 
conversion to CMYK.

• Lab (or L*a*b*) colour is a device 
independent colour. It has already been 
converted from RGB. This is still 
comparatively rare in a PDF file.

• Calibrated RGB is a form of RGB which 
includes all the information necessary to 
make a profile. Distiller can generate 
calibrated RGB colours under a number of 
circumstances, including when an RGB 
Photoshop EPS is placed on a page and 
distilled. Photoshop EPS files contain 
calibrated RGB even if using Photoshop 
4.0 or if ICC profiles are not being 
embedded by Photoshop 5.0.

• Device RGB is “generic” RGB, with no 
profile or other information to define how 
the colours are to be interpreted.

Remember that you can use the Info function 
in Quite A Box Of Tricks to find out whether 

an image is in Lab, Calibrated RGB, (Device) 
RGB or already in CMYK.

In the first two cases, no profile is required. 
The PDF file contains all the information 
necessary for an accurate conversion. In the 
final case, Quite A Box Of Tricks applies a 
fixed profile. The profile used is based on an 
emerging standard for “generic RGB” 
intended for use with office applications, web 
browsers and other applications where the 
users typically have no understanding of 
colour management. It is called sRGB and is 
described on http://www.sRGB.com. It has a 
gamma value of 2.2 (for those interested in 
such things).

In Acrobat 4.0 a fourth way to specify colours 
for conversion has been added. This uses 
ICC profiles inside the PDF file. Files can 
contain ICC profiles with one channel 
(greyscale), 3 channels (typically RGB) or 4 
channels (CMYK). Quite A Box Of Tricks 1.2 
is only interested in 3 channel ICC profiles. It 
will process these in one of two ways:

1. If you are using fast conversion, the ICC 
profiles are ignored and the information is 
converted as RGB. This is the only option 
in Windows 95 and NT 4.0.

2. If you are converting using a CMYK ICC 
profile, then the two profiles are combined 
to do an accurate colour conversion. If the 
profile is unusable, a warning message is 
issued, and an sRGB profile is used 
instead. See Were ICC profiles broken in 
Distiller 4.0? (page 20)

How do Distiller 3.0 options affect 
ICC processing?
Several Distiller options are important to how 
colour is managed.

• The Convert CMYK images to RGB 
option will produce smaller files, but this 
conversion is not based on any specific 
profile in Distiller 3.0. This means that 
colour information is lost. For best results 

http://www.sRGB.com/
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this option should be kept on, to preserve 
any CMYK colour that is in the file.

• The Color Conversion options determine 
how calibrated colour is handled.

• Unchanged tells Distiller to keep 
calibrated colour and Lab colour where 
it finds it, but to leave other colours 
alone. This is probably a useful default. 
Quite A Box of tricks will apply sRGB to 
the uncalibrated colours only.

• Device independent converts all RGB 
colour to calibrated RGB. This is useful, 
but you cannot control the profile used 
for uncalibrated colour, which is an 
RGB colour space (gamma 1.8) 
supplied by Adobe. If this is done, 
colour which is not originally calibrated 
will be calibrated in the PDF, and 
Adobe's profile will be used for 
conversion.

• Device dependent removes all 
calibration information, converting all 
RGB to device RGB. This is not 
recommended unless you need to 
remove a completely spurious 
calibration. Quite A Box Of Tricks will 
then apply sRGB profiles.

Distiller 4.0 and later also have similar 
options affecting colour processing. See 
Were ICC profiles broken in Distiller 4.0? 
(page 20)

Is Quite A Box Of Tricks a PDF Col-
our Management Solution?
We do not claim that the ICC profile handling 
has made Quite A Box Of Tricks into a full 
solution for colour management. This is 
partly because that was not the intention, and 
partly because of the limitations of Acrobat 
3.0 and 4.0. For instance, after conversion to 
CMYK, we cannot control how Acrobat 
displays the colours on screen. They may 
look wrong, even though they should print 
successfully.

With Quite A Box Of Tricks, you should keep 
your original RGB file. You should convert to 
CMYK once for each output device (e.g. 
proofer and press) for best results.

In fact, we would recommend that, for now, 
you should work with CMYK directly if you 
have a choice. Quite A Box Of Tricks is 
intended to be a valuable tool when there is 
no other choice, e.g. when processing office 
documents for offset printing.

Acrobat 5.0 does include important new 
options, View > Proof Colors and View > 
Proof setup. These should allow Acrobat to 
view color accurately and in turn could make 
Quite A Box Of Tricks part of a colour 
management solution. At the time of writing, 
there has not been enough industry 
experience of these options for us to say for 
sure whether they will deliver what people 
are expecting.

What about UCR, GCR and black 
generation?
UCR, GCR and black generation are all ways 
of expressing how much black ink is 
substituted for equal amounts of cyan, 
magenta and black. They do not apply when 
using Quite A Box Of Tricks.

First, the conversion that is performed uses 
either a fixed table (maximum UCR), or uses 
ICC profiles. ICC profiles control the 
complete conversion to CMYK, including all 
UCR, GCR and black generation, so it is not 
appropriate or possible to take any other 
settings into account. PDF files may contain 
UCR and GCR settings, preserved by 
Distiller, but you can see that Quite A Box Of 
Tricks will not use them.

Second, when outputting separations with 
the Crackerjack product (see 
http://www.lantanarips.com), you are offered 
choices of UCR and GCR. These apply only 
when RGB data is to be printed. So, if you 
have converted all colours to CMYK already, 
these settings can have no effect on printing. 
In fact, if you are printing separations with 

http://www.lantanarips.com/
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Crackerjack you do not usually have to 
convert to CMYK before printing, because 
the output device will do it for you according 
to the UCR/GCR specifications. This does 
not give the choice of an ICC profile, 
however.

Why is part of my file still in colour 
after converting to greyscale?
There are three reasons why part of the page 
may still appear to be in colour after you 
attempt to convert to greyscale.

1. The coloured area may have been added 
using the forms tool. Box Of Tricks does 
not change the colours in form elements, 
because it may prevent them from 
working if a form is to be filled in. If form 
elements have just been used to add text 
to a page, you can use the Fields function 
in Box Of Tricks to make them part of the 
page. After this, text should convert to 
black.

2. In greyscale set up, the option All spot 
plates removed, converted to 
greyscale may be switched off. If this is 
the case any spot colours will be left in 
colour. Try with the option on (it is on by 
default).

3. There is a bug in Acrobat 3.0x, which 
means that certain pages may not seem 
to change colour, even though the PDF 
file has been changed. In this case 
(unless you are using Acrobat 4.0) we will 
always issue the following warning:

Important: due to an Acrobat bug, parts of 
this file may seem unconverted, and there 
may be spurious warnings. We 
recommend you save, close and re-open 
this file.

It is important to follow these instructions, 
especially to close the file immediately 
after saving. If you do not close it, a 
number of surprising and alarming error 
messages may start to appear. 

It is sensible to use Save as with a new 
name, rather than just Save, so that you 
still have access to the original file. This is 
especially important if running in demo 
mode, as you won’t be able to remove the 
“X” over each page.

What is spot colour and how is it 
converted?
Spot colour is a term used in professional 
printing to mean a special colour of ink that is 
used to add colour to a page. This is different 
from ordinary colour printing, which mixes 
cyan, magenta, yellow and black (CMYK) to 
make full colour, also known as process 
colour. 

Spot colour is usually used to add one or two 
specific colours, as in the case where a page 
contains only black and red; it is more cost 
effective to use black and red ink than to set 
up and mix CMYK. Spot colour can also be 
used to add colours over the top of CMYK, 
such as a metallic finish on a book cover.

A PDF file can contain spot colours, and if 
colour separations are printed all of the 
colours will result in separate printing plates. 
This is not always desirable, though. 
Sometimes, designers make a mistake in 
page designs or illustrations, and might 
choose “spot red” when a page is to be 
printed with CMYK. If nothing is done about 
this, five printing plates may be produced - 
cyan, magenta, yellow, black and red. 

When you convert to CMYK, you have the 
option to select Convert all spot colour 
plates to process (CMYK). This is off by 
default. When it is on, the spot colour is 
converted to CMYK and will not produce an 
extra plate. The CMYK value used is the one 
chosen by the designer, which is the one you 
will see on screen, or when printing to a 
desktop colour printer. 

You have a similar option Convert all spot 
colours to greyscale when converting to 
greyscale. This is on by default, because 
people usually want a greyscale page to be 
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completely grey and black. By switching this 
option on, you can preserve a spot colour, 
while converting all the normal RGB and 
process (CMYK) into greyscale.

Acrobat 4.0 supports a new kind of colour 
specification called DeviceN. This allows you 
to mark on several spot plates at the same 
time. Starting with version 1.2f, Quite A Box 
Of Tricks can convert these to CMYK or 
greyscale in the same way as a single spot 
colour. Previous versions would not convert, 
and issue a warning message instead.

Were ICC profiles broken in Distiller 
4.0?
The following information is based only on 
our independent evaluation, and refers to 
features in Adobe’s products which are 
subject to change without notice. 

Acrobat 4.0 was first to support ICC profiles 
embedded in PDF files. The viewer may use 
them for display, and Distiller may add them 
to PDF files. A number of Distiller job options 
control this.

Our studies suggest that at least some of the 
time, Distiller 4.0 adds bad profiles to PDF 
files. The bad profiles are not usable.

It is important to realise that Acrobat viewers 
will never tell you that an ICC profile is bad. 
They are designed to ignore profiles that they 
do not understand. So, typically, information 
is displayed as if it is a normal RGB colour. It 
will look reasonably correct, but will not have 
accurate colour matching.

When Quite A Box Of Tricks converts to 
CMYK, and you are using ICC processing, 
incorrect profiles will produce a warning 
message. Quite A Box Of Tricks will 
automatically substitute an sRGB profile.

You may want to avoid Distiller’s ICC profile 
handling until the situation becomes clearer. 
There are two ways to completely avoid ICC 
profiles:

• Select Compatibility: Acrobat 3.0 on the 
General screen in job options; or

• If using Compatibility: Acrobat 4.0, then 
use Leave Color Unchanged on the 
Color screen in Job options.

Our initial studies suggest that Distiller 4.05 
did correct this problem.

What do the warning messages 
mean?
These are some of the warning messages 
that may be issued during colour conversion.

Warning: some parts of this PDF file didn't 
make sense. Results may be incorrect. 

This message occurs when Box Of Tricks 
couldn’t work out what part of a PDF file 
meant. That means it was left alone, but 
something may be wrong with the file. There 
are no cases where we would expect a valid 
Acrobat 3.0 file to produce this warning. 

Or, you may be using Box Of Tricks with a file 
created with a newer version of Acrobat than 
4.0. Because new versions of Acrobat might 
handle colour differently, please check our 
web site http://www.quite.com/ to be sure you 
have the latest version of Box Of Tricks.

Note: this PDF uses Calibrated RGB or Lab 
(device independent) colour. Calibration has 
been ignored, but the conversion to CMYK 
has been completed for these colours.

This message only occurs when you are not 
using ICC profiles to convert. It means that 
the file contained device independent colour, 
and acts as a warning that the original file 
might have been made with high 
expectations of colour accuracy.

Bad PDF warning: one or more images 
converted were missing some information. 
This probably means the PDF file was 
damaged before conversion, and results 
should be carefully checked.

Occasionally, damaged files have been 
found which can be viewed successfully, but 
which are not usable after conversion. In 
some cases they could be viewed but not 

http://www.quite.com/
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printed. This new message alerts you to the 
problem with the original file.

Warning: an embedded ICC profile was 
found which was not for RGB data. It might 
be for Lab or XYZ. This plug-in cannot use 
such profiles. The conversion was made 
using sRGB, but this may produce incorrect 
results.

This message only occurs when converting 
to CMYK with an ICC profile, and when an 
embedded ICC profile has been found that 
we cannot handle. ICC profiles can contain 
many different kinds of colour. Most 3-
channel ICC profiles are RGB. There are 
other kinds, but Quite A Box Of Tricks does 
not handle them. We also do not expect to 
find them. If you encounter a PDF file which 
gives this message, please contact Quite 
Software.

Warning: a bad embedded ICC profile was 
found in the file.It was ignored and treated as 
sRGB. Note that bad profiles never produce 
error messages, they are just quietly ignored.

This message only occurs when converting 
to CMYK with an ICC profile, and when an 
embedded ICC profile has been found that is 
damaged. It is important to realise that 
Acrobat will tolerate bad ICC profiles, and 
quietly use an alternative, with no messages. 
This message may be the only notification 
you see that the profiles are bad.

Our initial studies suggest that Distiller 4.0 
(but not 4.05) frequently embeds damaged 
ICC profiles, so this message may be 
common. See Were ICC profiles broken in 
Distiller 4.0? (page 20)

Warning: this document was exported from 
Adobe InDesign. You may need a newer 
version of Acrobat (4.05 or later) to avoid 
errors. Continue anyway?

Adobe InDesign produces correct PDF files, 
but they can be very complicated. Releases 
up to and including 4.0 can produce errors, or 
damage files, or recolour or move objects on 
the page, if Quite A Box Of Tricks makes any 
changes to files made from InDesign. It is 

important to obtain the 4.05 upgrade (or later) 
from Adobe if you are working with InDesign 
files.

Warning: this PDF has some transparency 
on pages which were converted.The results 
from converting transparent colours may not 
always be as expected.

This message is new for Quite A Box Of 
Tricks 1.5 and can only appear in Acrobat 
5.0. Transparency is a new feature of 
Acrobat 5.0 which allows interesting special 
effects. However, if you need to convert the 
colours in a transparent area, you may not 
get the effects you expect. Colours can be 
combined in different ways; if they are simply 
mixed the results may be fine, but there are 
many special ways of blending which will give 
radically different answers if the colours are 
converted. Quite cannot foresee any way in 
which special transparency effects can be 
recoloured in the near future. If you get this 
message the conversion has gone ahead 
anyway. Please check the results very 
carefully.

Warning: this PDF contains JPEG2000 
images that could not be converted.

At the time Acrobat 6.0 and Quite A Box Of 
Tricks 1.6 were produced, the JPEG2000 
standard was still not finished, and some 
information was unclear. As a result, Quite A 
Box Of Tricks does not process all possible 
JPEG2000 images. If you get this error, 
please contact help@quite.com, we may be 
interested to see the original file. If this 
message is issued, the file is still valid, but 
not everything in it was converted.  This 
message also appears if you attempt to use 
JPEG2000 images in a version of Acrobat 
older than 6.0.

Why can I undo All Text To Black 
but not the other conversions?
When you convert all text to black, no 
information is actually removed.
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Instead, extra instructions are added to set 
the colour to black whenever text appears. 
Our extra instructions are marked, so it’s 
possible for us to remove them. Working this 
way doesn’t increase the file size by very 
much.

When doing the other colour conversions, 
everything in the file is potentially changed, 
including large images. If we were to keep the 
original images as well as the new ones, then 
the file would potentially grow enormously in 
size.

There’s another reason why we made it easy 
to undo this. Unfortunately, sometimes text is 
no longer readable after converting to black. 
If the text was on a white or light coloured 
background, there should be no problem. 
But, if you had white text on a black 
background, then this will be invisible after 
the text is converted to black. After 
converting text to black you are advised to 
check the file and undo the conversion if it 
has made any unwanted change.

Text didn’t convert to black - why 
not?
There are two reasons why text may not 
convert to black.

1. It may not actually be text. For instance, it 
may be a scan of a page containing text; 
this will still be an image and not text, 
unless you use Acrobat Capture.

Alternatively, the text may have been 
created in an application, such as 
CorelDRAW, Macromedia FreeHand, or 
Adobe Illustrator, which allow text to be 
converted to curves. If text is converted to 
curves it is no longer recognisable as text.

One way to check if an area really 
contains text is to use the Info tool and 
click on the target area.

2. The text may have been added using the 
forms tool. Box Of Tricks does not change 
the colours in form elements, because it 
may prevent them from working if a form 

is to be filled in. If form elements have just 
been used to add text to a page, you can 
use the Fields function in Box Of Tricks to 
make them part of the page. After this, 
text should convert to black.
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Form field management
• Why would I want to make form fields part 

of the document?  23
• Why would I want to remove form fields?  

23 
• What’s this about annotations?  23
• I get errors using the text touch-up tool. 

Why?  24

Why would I want to make form 
fields part of the document?
Mostly, form fields are used to add interactive 
features to a PDF document. Making them 
into part of the document doesn’t seem to 
make any sense, because afterwards they 
would not be interactive. Buttons could not be 
pressed, and text fields could not be filled in. 
Occasionally this is useful to “lock” a file after 
it has been filled in, so it cannot easily be 
changed any more.

Sometimes, though, form fields are used to 
make changes to a document. It is one of the 
simplest ways to add text, for instance. In this 
case the interactive features are not required, 
and you may want to make them part of the 
document for one of the following reasons.

• The document is then harder to alter by 
accident.

• Provided you select to remove all the non-
printable form fields and use the Entire 
document setting, this can shrink the 
PDF file.

• Some users have reported problems 
where the appearance of form fields 
changes, or they disappear, when 
printing. This should not happen if they 
are made part of the document.

• Version 1.0 of our Quite Imposing and 
Quite Imposing Plus products will not 
preserve form fields when a page is being 
imposed.

Once a form field is made part of the 
document it will always display and print 

along with it, but has no interactive 
properties. 

Why would I want to remove form 
fields?
The main reason to remove form fields is to 
shrink a file. It can also remove confusion, by 
removing non-printing fields which mean that 
what you see on screen is not what prints.

One time when removing fields is helpful is 
after documents that contain form fields have 
been merged, extracted and so forth. This 
can, it seems, leave references to many 
“dead” fields on deleted pages still occupying 
space in the file.

To save space it is essential that you select 
Remove all form fields and apply to the 
entire document. If you remove from a page 
at a time, the form fields are deleted from the 
page, but all of the fields are left behind in a 
central list for the entire document.

What’s this about annotations?
Annotations are not new to Acrobat 4.0, but 
Acrobat 4.0 made a lot of changes to them. 
An annotation is extra information that sits on 
top of a PDF file, but is not really part of the 
page. The best known example is note 
annotations which appear either as a small 
icon, or as an open box containing text.

Acrobat 4.0 added a lot of new annotation 
types, such as scribbles, stamps, text 
highlighting, free text annotations, and 
boxes. Also, Acrobat 4.0 can now print 
annotations, so these features are very 
useful for mark-up.

However, printing can also be an 
inconvenience. When printing with File > 
Print, there is an option to switch on or off 
annotations. However, when exporting 
PostScript or EPS there seems no way to 
turn this off in Acrobat 4.0 (this may change 
in future releases). This is why Quite A Box 
Of Tricks allows the option to remove 
annotations.
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Annotations can also be made a part of the 
document. In this way, mark-up can be made 
permanent and un-editable, perhaps in 
preparation for passing a document for 
review in a second group.

Strictly speaking, form fields are a kind of 
annotation too. But it is convenient to treat 
them as separate.

I get errors using the text touch-up 
tool. Why?
After a form field or an annotation has been 
made a part of a document, you may wish to 
edit it using the text touch-up tool. 
Unfortunately, there appears to be a problem 
with Acrobat 4.0. Although converted form 
fields are valid, any attempt to edit the text 
will cause a range of surprising errors, and 
can seriously damage the document. 

We understand that Acrobat 4.05 fixed this 
problem.

If you make a change and get error 
messages, you should close the PDF file 
without saving to avoid potentially losing all 
of the page contents.

Transformation
• Why use the transformations?  24
• Why would I thicken lines in a file?  25
• Why isn’t the line thickness in points?  25
• Is there any time a line doesn’t thicken?  

25
• What happens to links when I transform 

files?  25

Why use the transformations?
There are a several different transformations, 
and there is also the ability to thicken lines, 
which happens to be on the same screen.

• Mirroring a page may be used for a 
special effect; or before producing output 
on a transparent sheet; or to create 
transfers for fabric. By mirroring an image 
before printing on a transparent sheet, 
you can control which side it is viewed 
from. Placing an image on the back of the 
sheet can help to protect it from 
scratching.

• A scaled image may be used before 
printing, or to prepare a document with 
consistent sized pages. You may scale 
down to fit a sheet (though Acrobat’s own 
Shrink to fit option will do this when 
printing) or scale up to fill a sheet.

• Rotated images may be used for special 
effects. You should note that each time 
you rotate a page, it is likely to get larger 
(since the page has to be square). Also 
note that, if you rotate a cropped page you 
can no longer un-crop it to get back the 
hidden areas.

You should note that even if you rotate by 
90, 180 or 270 degrees this is different 
from Acrobat’s rotate function. Box Of 
Tricks actually rotates the contents of the 
page. Acrobat just remembers “this page 
is to be shown rotated”. This usually 
makes no difference, but some software 
may behave differently, possibly including 
the forms tool.
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Why would I thicken lines in a file?
It is very common for the software that 
creates pages to ask for very thin lines. They 
might ask for 0.001 inch, or even for a width 
of 0, which means “the thinnest line 
possible”. These usually look fine on a 
desktop printer.

Unfortunately if pages like this are to be 
printed professionally, they may be output on 
devices with a very high resolution. In this 
case very thin lines may appear on the page 
(or sheet of film, or printing plate) but are so 
thin they need a microscope to see them, and 
may disappear completely in the final 
product.

You can easily thicken all the lines in a file, by 
specifying a minimum width. Any line which is 
thinner than the minimum will be increased to 
the minimum you choose.

Why isn’t the line thickness in 
points?
The initial value is 0.1 points, a commonly 
used value, equivalent to 0.0014 inches or 
0.035 mm. The units used on screen are the 
same as the default Acrobat units (from 
general preferences).

If you know what value you want in points, but 
the current units are inches or millimetres, 
you can use a special trick. When you type a 
value you can follow it with / and a number to 
divide. For instance 1/100. (Note: you can’t 
do general arithmetic, just this single 
division).

If the current units are inches and you want to 
enter a value in points, divide by 72. Or 
rather, let Box Of Tricks do it for you.

To get a value of 0.2 points from inches, you 
could type 0.2/72.

If the current units are mm, divide by the less 
obvious number of 2.83. 

To get a value of 0.2 points from mm, you 
could type 0.2/2.83 instead.

Is there any time a line doesn’t 
thicken?
Lines will usually thicken. However, there are 
a number of reasons why you may still end up 
with a very thin line.

1. The line may not be drawn as a line (or 
outline), but as a very thin rectangle, 
which is then filled in. This will not be 
thickened.

2. Lines in form fields will not be thickened. 
This should not be a major problem, as 
the forms tool is unlikely to create very 
thin lines. See Form field management 
(page 23).

One other case should be noted. It is 
possible to have objects in a file which are 
scaled differently in the x and y directions. 
For instance, if an EPS file is placed in Adobe 
PageMaker, you can shrink it 50% 
horizontally, to make it a tall, thin, shape. This 
has to be done with caution for files 
containing lines, as the lines are scaled to 
match. So, horizontal and vertical lines may 
not have the same thickness. 

Box Of Tricks will recognise this case, and 
uses an average width as its basis for 
thickening lines.

What happens to links when I trans-
form files?
When you transform a page by mirroring, 
scaling or rotating it, nothing special is done 
with links. This usually mean the links will end 
up attached to the wrong part of the page, so 
many of the transformation functions are not 
suitable for use with interactive files.

Form fields, too, are not handled specially 
and may be left in the wrong place. If form 
fields are being used to add marks to the 
page, you may wish to use the Field tool to 
make them part of the document before you 
transform it. See Form field management 
(page 23).
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PDF Info
• How do I use the info tool?  26
• What does the font information mean?  26
• What does the image information mean?  

27
• I’m not getting information on my 

text/image - why?  29
• What does the Shrink Image button do?  

29
• What do the Find and Next buttons do?  29

How do I use the info tool?
The info tool will tell you information about 
your PDF file that can be hard to find in other 
ways. To start the info tool, you can click on 
the Info button in the Box Of Tricks main 
window, or use the new “i” icon in the toolbar. 
When the info tool is active, the cursor 
changes to an “i” and an arrow.

If you click on text, it will tell you the font 
name and size, and important information 
about the font: whether it is embedded, and 
whether an embedded font is subsetted. 

If you click on an image, it will tell you a lot of 
information about that image, especially in 
relation to its size and colour type. 

When text or images are selected that area of 
the page is highlighted. The highlighting is 
done by reversing colours, because this is 
the fastest way to highlight an area, and 
allows the highlighting to be removed.

After you click on an image you can also use 
Shrink Image to use the Shrink settings and 
(possibly) make it smaller.

Finally, the Find and Next buttons can be 
used to locate images that might need 
special attention. If you are working with 
colour separation, you can look for RGB 
images. If you are concerned with size, you 
can look for the largest images in the file - 
often just one or two images dominate the file 
size.

To get information on text or images, just 
click on them. The information shown will 

immediately update. Sometimes text and 
images overlap. The rule followed is: if you 
click on text, you get information on the text. 
If you click on overlapping images (which 
aren’t covered by text) it will select each of 
the images in turn.

What does the font information 
mean?
The font info shown when you click on a 
piece of text has five pieces of information.

1. The font name. This may be the name you 
expect, but sometimes it is different. If a 
name has six random letters and “+” 
before it, as in BGMOAF+Frutiger-Bold, 
this is done when a font is made into a 
subset. Each subset has a different name, 
to keep them from getting mixed up. 

Sometimes the font name is meaningless, 
like “F23”, or “MSTT23A07”. In this case 
you can’t directly find out the original 
name.

2. The font size is given, in points. 

3. The font type is given. Acrobat supports 
several different kinds of font, including:

• Type1, a PostScript font (also known 
as “ATM fonts”). When TrueType fonts 
are printed through PostScript, they 
often turn into PostScript fonts too.

• TrueType, a TrueType font.

• MMType1, a multiple-master 
PostScript font - one that can take 
different shapes.

• Type3, a font actually made by drawing 
line art and images. The quality of 
these is often poorer than PostScript or 
TrueType fonts.

• Type0, Type 1(CID) which is also 
known as CIDFontType0, and 
TrueType(CID) which is also known as 
CIDFontType2: these are mainly used 
for very large fonts typically found in 
Far Eastern languages. These are also 
starting to be used in Western files, to 
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hold Unicode font information, as they 
overcome the limit of 256 characters 
per font. For instance, Adobe InDesign 
will use these fonts.

4. Whether the font is embedded. If the font 
is not embedded, and it is not installed on 
your local computer, Acrobat will create a 
substitute with the right spacing, but 
which may look different from the original 
design. Certain fonts are built-in to 
Acrobat and are never embedded. These 
will be shown as Never (built-in).

5. Whether the font is subsetted. A 
subsetted font includes only the 
characters used. For instance if only the 
word QUITE appeared in a file, only the 
five letters Q, U, I, T and E would remain 
in the file. This cuts the size down, but 
makes it difficult to edit - if you changed 
the word to QUOTE, the letter O would be 
missing.

What does the image information 
mean?
Box Of Tricks will report detailed information 
on an image in a PDF page if you click on it. 
Perhaps we should start by defining what an 
image is in PDF terms. An image is a 
collection of pixels (dots) where each can 
have a different colour. Images are one of the 
three basic types of object on a PDF page 
(the others are text and line art).

Usually there is an obvious match between 
an image in a page and a graphic file such as 
a TIFF or BMP file used to make up the 
document. Commonly, an image is a single 
photograph or screen shot, but it may also be 
a scan of any kind of original, so it may 
appear to contain text or lines. 

Images are sometimes used for special 
effects, for instance a colour gradient, where 
an area changes from one colour to another, 
may be made using an image. When you run 
Acrobat Capture, the unrecognised areas of 
the page may become a collection of many 
images, mixed with the text.

Sometimes the area highlighted when you 
click on the page may not be what you 
expect. One reason is that images can be 
larger than they seem, and a “clipping path” 
is used to cut-out a window through which 
you see the image. In some cases what 
seems to be one image might be stored as a 
series of narrow or thin images side by side. 
And sometimes what appears to be an image 
might not be an image at all - see I’m not 
getting information on my text/image - why? 
(page 29)

Assuming you have clicked on an image and 
the area is highlighted, eight pieces of 
information are now given.

1. The image size in pixels. This is the true 
number of pixels (dots) which make up the 
image.

2. The image size in points (1/72 inch, 0.35 
mm). This is the size of the upright 
rectangle containing the image, so if an 
image is rotated this is not the same as its 
own width. Still, this information together 
with the pixel size can be used to work out 
the resolution - so Box Of Tricks does this 
and shows it as item 8.

3. The uncompressed size is the “raw” size 
of the image. That is, the number of bytes 
needed to hold the image in memory, if it 
is not compressed at all. This is based on 
the size in pixels. For instance a typical 
RGB image uses three bytes per pixel, so 
if the image size is 100 x 200 pixels, the 
size in bytes is 100 x 200 x 3 = 60000 
bytes - about 60K (1K is 1024 bytes).

4. The compressed size is now shown. This 
is the size actually occupied on disk by 
this image, in the PDF file. There is no 
way to say what this value will be in 
advance, because each image may 
compress slightly differently. 

This value may be shown as n/a for inline 
image. Inline images are very small 
images that are mixed with the text and 
line art. They are not usually compressed 
themselves, but the text and line art as a 
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whole, including the inline images, is 
usually compressed with ZIP. See What is 
“text and line art”? (page 9)

5. Compression ratio is the value of 4 
(compressed size) as a percentage of 3 
(uncompressed size). For instance if an 
image of 60K is compressed to 15K, the 
compression ratio will be 25%. Typically, 
more aggressive JPEG compression will 
reduce this value. This value is not shown 
for inline images.

6. The compression type is shown. This is 
the value used by Distiller or PDFWriter to 
create the PDF file, or by Box Of Tricks 
when shrinking the image. ZIP, CCITT 
group 4 and JPEG have been described 
in What do the compression types mean? 
(page 10) 

Where JPEG is used, Box Of Tricks 
attempts to work out the compression 
originally used (e.g. low, high, extra). 
Photoshop’s JPEG compression levels (a 
number from 0 to 10) are also recognised. 
Distiller 3.0, 4.0, 4.05 and 5.0 all give 
different results, and a version number will 
be included. In some cases, Quite A Box 
Of Tricks gives a choice e.g. 3.0 med/4.05 
max. This means it cannot tell the 
difference.

Quite A Box Of Tricks can also recognise 
the JPEG compression performed by 
Adobe Photoshop. In Box Of Tricks 1.5, 
this is based on Photoshop 6.0. In 
Photoshop 6.0, JPEG is a quality number 
from 0 (lowest) to 12 (highest), and these 
are reported. If the file was created with 
Photoshop 5.0, you should subtract 2 
from the number given. For example, if 
you see a compression of Photoshop(3), 
this was a quality level of 3 from 
Photoshop 6.0, or 1 from Photoshop 5.0.

There are many other ways a JPEG might 
be compressed and these will be shown 
as JPEG Unknown. Please remember 
that there are many other programs which 
create PDF. Some will show up as 
Unknown, while others will be mistaken 

for a setting in Distiller or Photoshop, and 
reported wrongly.

Other types you may see include Run 
length and CCITT group 3, which are 
compressions for monochrome images 
which are usually less effective than 
CCITT group 4. LZW is used by Acrobat 
2.1 and by Acrobat 3.0 in 2.1 compatibility 
mode. It is similar to ZIP but usually 
slightly less effective.

From Acrobat 6.0 you may see 
JPEG2000. This is a new compression 
“from the makers of” JPEG. It will not 
display in earlier releases. JPEG2000 
compression is generally better than 
JPEG, in both quality and compression 
ratios.

If you see ASCII as well, the PDF file was 
created with the ASCII option, and the 
image occupies around 20% more space 
than necessary.

You can convert an image to non-ASCII 
ZIP or CCITT group 4 using the 
Lossless setting in the shrink function - 
see What compression settings should I 
use? (page 10)

7. The image type is shown. These settings 
reflect the way the image is stored, and 
often the number of colours. Settings 
include the common RGB, CMYK, 
Greyscale and Black and white (i.e. 
monochrome). Calibrated RGB and Lab 
are device independent colour, and are 
mentioned in What about input profiles? 
(page 17) and How do Distiller 3.0 options 
affect ICC processing? (page 17) 

CalGray is very similar to greyscale, but is 
a “device independent greyscale”.

ICC-Based colour is also device-
independent colour, using an ICC profile. 
It can have 1, 3, or 4 components. 
ICCBased x 3 is typically a kind of RGB 
(although it could also be other kinds of 
colour). ICCBased x 4 is typically CMYK 
colour with an output profile. ICCBased x 
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1 is a kind of calibrated greyscale. See 
What is an ICC profile? (page 15)

Mask (1-bit) images are black and white 
images, but they are special because the 
white part is transparent. Mask images 
may also be any colour, not just black.

Indexed images are made of a specific 
list of colours, often 256 colours. This is 
very similar to the way GIF files are 
stored. Box Of Tricks also shows what 
type of colours are in the list. Most often 
you’ll see Indexed RGB but after colour 
conversion you might also see Indexed 
CMYK.

Images made using spot colours are rare 
but if they are found, Box Of Tricks will 
report them with the plate name e.g. Spot 
Red.

DeviceN colours are also rare in images 
but may result from a Duotone in 
Photoshop. These write to multiple spot 
plates. This will be shown for instance as 
DeviceN x 2 if there are two plates 
involved.

8. The resolution shown is worked out from 
items 2 and 3 - it is not shown if the image 
is not upright. It is usually a single figure in 
dpi (dots per inch), but where the image is 
not scaled uniformly you will see two 
numbers e.g. 100 x 110 dpi. Do not be 
surprised if the resolution is slightly 
different from what you expect e.g. 72 dpi 
might appear as 71 dpi or 73 dpi or even 
72 x 71 dpi. These variations are due to 
rounding errors at various stages and can 
be ignored.

When you have used the Shrink function and 
an image has been changed, but not yet 
saved (i.e. Restore is still available), items 4 
(compressed size) and 8 (dpi) show a before 
and after value for you to compare. For 
instance 72 dpi (was 150). 

I’m not getting information on my 
text/image - why?
If you click on what seems to be an image or 
text and nothing happens, the chances are 
that it is neither image nor text. It may be a 
drawing with lines and fills, or even a text 
drawn as curves. No useful information can 
be given in this case.

If the page was created using “Web Capture” 
in Acrobat 4.0, you will not be able to select 
any background graphics. These are made 
using an Acrobat feature called “patterns”, 
and there is no access to them.

What does the Shrink Image button 
do?
The Shrink Image button can be used after 
you click on an image and information is 
shown. It can also be used after Find or Next 
has highlighted an image.

Apart from the fact that it works on only a 
single image, rather than the entire document 
or the an entire page, the choices are 
identical to those described in the section on 
Shrinking (page 6).

Note that after you use Shrink Image, you 
can switch to the Shrink screen and use the 
Restore button, to put the image back as it 
was, provided you have not saved or 
otherwise modified the file. Savings made by 
shrinking single images are also shown on 
the Shrink screen.

What do the Find and Next buttons 
do?
The Find and Next buttons help you identify 
images in a file that might be of special 
interest. When you click Find you can 
choose one of these options.

• Search for the largest image in the 
document. This is the image which will 
actually use the most disk space, so the 
compressed size is the one of interest. 
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Sometimes if a document is unexpectedly 
large you can identify just one or two 
images that are causing the problem. You 
can then use the Shrink Image button to 
do special processing on such images.

• Search for the first RGB image. In fact, the 
search is for any image that would be 
changed if converted to CMYK, so this 
also includes Lab colour images. 

The image matching your requirements is 
highlighted and information about it is 
displayed.

The Next button continues the most recent 
search. So it will find the next largest image, 
or the next RGB image.

Automating Quite A Box Of 
Tricks
• Can I automate Quite A Box Of Tricks?  30
• How do I use automation with Acrobat 5.0 

onwards?  30
• What is pdfBatchProcess Pro?  31
• How do I use pdfBatchProcess Pro with 

Quite A Box Of Tricks?  31

Can I automate Quite A Box Of 
Tricks?
It is not unusual to have a large collection of 
files, all of which need the same treatment, 
such as shrinking or converting to CMYK. 
There are two methods you can use to 
automate the functions of Quite A Box Of 
Tricks.

• If you have Acrobat 5.0, you can use the 
“batch sequences” feature that is built in 
to Acrobat. Quite A Box Of Tricks 1.5 now 
provides all of its features (except Info) to 
Acrobat for use in batch sequences. 

• With any version of Acrobat you can use 
pdfBatchProcess Pro. This is an extra-
cost plug-in for Acrobat created by callas 
software.

We would like to caution you that we only 
consider Acrobat suitable for light duty 
automation. By “light duty” we mean perhaps 
a few dozen files at a time, with someone 
checking occasionally to make sure that 
things are going correctly.

We do not support “heavy duty” automation, 
for instance hundreds of files left to run 
overnight. There is a high chance that 
Acrobat will fail during such a task; it was 
written as an interactive tool. 

How do I use automation with Acro-
bat 5.0 onwards?
This information is an outline, because 
automation is a standard Acrobat 5.0 feature, 
and should be covered in the Acrobat Guide 
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in more detail. Automation is also in Acrobat 
Professional 6.0 or 7.0, but is not in the 
Acrobat Standard 6.0 or 7.0 product.

Actions from Quite A Box Of Tricks can be 
combined with other actions. You can use 
them to process single files, all the files in a 
folder, or all open files (without saving). You 
can automate all of the Quite A Box Of Tricks 
functions, except those related to Info. 
However, they can only be applied to whole 
documents, not to single pages.

Here is an example, which uses the “Chosen 
for Screen” setting in the Shrink function, and 
applies this to every file in a folder. 
Remember that you need Acrobat 5.0 or 
Acrobat Professional 6.0/7.0 to follow this 
example.

1. In Acrobat 5.0 use File > Batch 
Processing > Edit Batch Sequences or 
in Acrobat Professional 6.0/7.0 use 
Advanced > Batch Processing.

2. Click New Sequence and type a name for 
the sequence, say Shrink Some Files.

3. The Batch Edit Sequence dialog opens. 
Click Select commands.

4. Scroll down in the list of available 
commands in the left hand panel to find 
Quite A Box Of Tricks. Click on 
Shrinking then the Add button. A 
Shrinking action should appear in the 
right hand panel.

5. Double click on Shrinking in the right 
panel.

6. Under settings, select Chosen for screen 
and click OK.

7. Click OK again to return to the Batch Edit 
Sequence dialog. Check that Run 
commands on says Ask when 
sequence is run. Also set Ask when 
sequence is run for Select output 
location.

8. If your files are to be used on the web, 
they should be optimized. Click Output 
options and make sure there is a check 
against Fast web view.

9. Click OK. The sequence is now saved.

Now you can run the selection at any time, by 
selecting File > Batch Processing > Shrink 
some files. You can select one or more files 
to process, then you will be asked for an 
output directory. 

This is just one of many ways to set up batch 
sequences.

You may find that you want to record the 
messages displayed on screen during batch 
processing. You can do this by asking 
Acrobat to keep a log file. This is controlled 
by choosing Edit > Preferences > General, 
then selecting Batch processing. On this 
dialog, switch on Save warnings and errors 
in log file. Click Choose location to select a 
folder for the log files. All the messages from 
Box Of Tricks are considered to be warnings, 
so everything is logged.

What is pdfBatchProcess Pro?
pdfBatchProcess Pro is a plug-in for Adobe 
Acrobat created by callas software. At the 
time of writing, it is available only as a part of 
the pdfToolbox product. 

It can be used to automate certain tasks in 
Acrobat.

Please visit http://www.callas.de/ for more 
details.

How do I use pdfBatchProcess Pro 
with Quite A Box Of Tricks?
These instructions are subject to change 
without notice. For support questions related 
to the general use of pdfBatchProcess Pro 
please contact callas software directly.

You can automate almost all of the functions 
in Quite A Box Of Tricks except those related 
to INFO. All the functions apply to the whole 
of a document, and do not create a copy.

1. Start the plug-in

http://www.callas.de
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Once pdfBatchProcess Pro is installed, you 
will find it in the Plug-ins menu. To use this, 
you must first close all open documents.

2. Create a new job.

Click the New button to create a new job, or 
task. This task must be given a name.

For each automation action you must define 
four folders. They should each be new 
folders with no other purpose.

• In is a folder into which you will place files 
that you want to process. Files will be 
removed from here as soon as they are 
processed.

• Result is used for files created as a side-
effect of the automation. Box Of Tricks 
does not create any files, but this folder 
must be defined.

• Error is a folder into which files that 
cannot be processed will be moved. 
Errors might include a non-PDF file, a 
damaged file, or a protected file.

• Processed is a folder where processed 
files will be placed. Box Of Tricks will 
change the input file in the way you 
choose, and the result will be saved to the 
processed folder.

3. Add an action

Each job can have one or more actions; it is 
no use until you define an action. Click the 
New button to add an action. You can add 
more than one action, even from different 
plug-ins, and they will be processed in order. 
For each action choose the following.

• Plug-in is the name of a plug-in. Only 
plug-ins specially written for 
pdfBatchProcess Pro can be automated. 
You can choose Quite A Box Of Tricks 
from the list of plug-ins.

• Command is one of the actions in the 
plug-in. With Box Of Tricks there are a 
number of actions to choose from. See 
the table Quite A Box Of Tricks 
Commands for pdfBatchProcess Pro 
(page 32) for details.

• Parameter appears only for certain 
actions. Where an action supports 
parameters, you must pick exactly one. 
On windows you must pick a parameter 
unless the option is greyed out, otherwise 
you will get an error at the time the action 
is run. See the table Quite A Box Of Tricks 
Commands for pdfBatchProcess Pro 
(page 32) for details.

4. Start processing

Save action and job by clicking OK. Then 
click the Start button. PDFBatchProcess Pro 
will immediately start processing the files in 
the In folder.

On success, files will be written to the 
Processed folder.

5. If required, check the log

If you find anything in the Error folder you will 
want to check the log. PDFBatchProcess Pro 
starts a new log each day, with the current 
date. These files are never automatically 
deleted.

The log will show every file processed, and 
includes any information messages written 
by the plug-in. If the plug-in fails, and a file is 
moved to error, you should be able to find out 
why this happened by reading the log file.

Log files are simple text files, not PDF files.

Table 1: Quite A Box Of Tricks Commands 
for pdfBatchProcess Pro

Command Comments

All text to 
black

No parameter. 

Convert to 
CMYK

Parameter is Use current 
settings. Uses the set-
tings most recently made 
using Setup. Currently no 
way to save multiple set-
ups.
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Convert to 
greyscale

Parameter is Use current 
settings. Uses the set-
tings most recently made 
using Setup. Currently no 
way to save multiple set-
ups.

Flip (mir-
ror) PDF 
pages

Parameter is either Hori-
zontal or Vertical.

Form fields 
and anno-
tations

Twelve parameters. Each 
possible combination of 
Form fields, Annotations 
or Both: combined with 
remove all, remove print-
able, fix printa-
ble/remove or fix 
printable/ignore. 

Free rotate 
PDF pages

Due to a limitation of pdf-
BatchProcess Pro you can-
not type an angle, only 
choose from the parameter 
list. This includes the angle 
most recently used.

Optimize 
PDF

No parameter. This may be 
used as the last item in a 
list of actions, especially if 
preparing for the web.

Scale PDF 
pages

Due to a limitation of pdf-
BatchProcess Pro you can-
not type a scale, only 
choose from the parameter 
list. This includes the scale 
most recently used and 
some convenient prede-
fined values (e.g. 200%, 
and scaling between popu-
lar paper sizes).

Table 1: Quite A Box Of Tricks Commands 
for pdfBatchProcess Pro

Command Comments

Shrink PDF Parameter is a the name of 
predefined or custom set-
ting. You can give your own 
settings a name. If you 
change the settings, the 
actions use the current def-
inition of the name.

Thicken 
hair lines

Due to a limitation of pdf-
BatchProcess Pro you can-
not type a line thickness, 
only choose from the 
parameter list. This 
includes the thickness most 
recently used and also the 
default value (0.1 points).

Table 1: Quite A Box Of Tricks Commands 
for pdfBatchProcess Pro

Command Comments
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